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Chapter 1: Introduction to Studio Monitor Express

Studio Monitor Express (SME) is a powerful and flexible audio monitoring software application that runs on your workstation or a ded-
icated computer. SME controls the routing between applications, external inputs, and ASIO hardware just like the master and commu-
nications section on a typical mixer. It provides a professional surround sound monitor mixer with two 5.1-channel outputs and one ste-
reo output, each with level, cut, and talkback controls. SME outputs are routed to the audio 1/0 hardware and controlled from the
monitor section on Artist Series media controllers. SME can also listen to external inputs without another application open.

SME is included as a separate installer on the EuControl CD that shipped with your unit. You can also download SME from http://eu-
phonix.avid.com/artist/ux/euphonix/mc_support.html. The Euphonix Monitor Core Audio driver (Mac) and ASIO driver (Windows)
are included to integrate your applications with SME.

SME Mac and Windows versions are somewhat different, so they are discussed in their own chapters.

Q SME requires additional CPU resources beyond those used by EuControl. If you do not use its features, or your audio interface soft-
ware already provides this functionality, then you do not need to install SME.

System Requirements and Compatibility

Avid can only assure compatibility and provide support for hardware and software it has tested and approved. For downloads and other
Artist Series resources, visit: www.avid.com/artistsupport

About This Guide

Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key
Control-click Hold down the Control key and click the mouse button
Right-click Click with the right mouse button

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The names of keys on Artist Series hardware are in bold (such as SHIFT and SEL). Do not confuse the SHIFT key on Acrtist Series hard-
ware with the Shift key on your computer keyboard.

The following symbols are used to highlight important information:

Q User Tips are helpful hints for getting the most from your system.
A Important Notices include information that could affect your data or the performance of your system.
Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid guides.
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About www.avid.com

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your system. The following
are just a few of the services and features available.

Product Registration Register your purchase online.

Support and Downloads Contact Avid Customer Success (technical support); download software updates and the latest online manu-
als; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide Pro Tools
community on the User Conference.

Training and Education Study on your own using courses available online or find out how you can learn in a classroom setting at a cer-
tified Pro Tools training center.

Products and Developers Learn about Avid products; download demo software or learn about our Development Partners and their
plug-ins, applications, and hardware.

News and Events Get the latest news from Avid or sign up for a product demo.
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Chapter 2: Installing Studio Monitor Express

The EuControl installer includes the SME installer as well as Mac and Windows audio drivers that integrate with the applications
you use with SME. You can always download the latest version of EuControl from www.avid.com/artistsupport.

Installing SME

To install SME:
1 Do one of the following:

» Download the most recent EuControl installer for your computer platform from www.avid.com/artistsupport. After down-
loading, make sure to decompress the installer (.dmg on Mac or .zip on Windows).

* Insert the Installer CD into your computer.
2 Open the Extras folder, and double-click the Studio Monitor Express installer application.

3 Follow the on-screen instructions to complete the installation.

4 When installation is complete, click Quit (Mac) or Finish (Windows).

Removing SME

To remove SME from your system, follow the instructions below for your computer platform.

To remove SME on Mac:

1 Make sure you are logged in as an Administrator for the account where SME is installed.
2 Go to Applications/Euphonix and double-click Uninstall Studio Monitor Express.

3 Click Yes to proceed with the uninstall.

4 Enter your Administrator password and click OK.

5 After the uninstall finishes, click Close.

To remove SME on Windows 7:

1 Choose Start > Control Panel.

2 Under Programs, click Uninstall a program.

3 Select Studio Monitor Express from the list of installed applications.
4 Click the Change button.

5 Select the Modify button.

6 Click Next.

7 Deselect Studio Monitor Express.

8 Click Next.

9 Follow the on-screen instructions to complete the removal.
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Chapter 3: Using SME on Mac

Once installed and configured, SME lets you do the following.

Switch between multiple speaker setups
Mute and dim monitor outputs
Utilize Talkback

 Adjust levels for external sources, such as a CD player

Five tabs help patch and configure audio between SME and your workstation.

Sources tab: Create SME Sources (see “Sources Tab” on page 7)

Patching tab: Assign routing between SME, applications, and hardware (see “Patching Tab” on page 8)

Config tab: Configure Dim, Fixed, and Talkback levels, and select an Audio Device (see “Config Tab” on page 9)

Main tab: Assign Sources to monitor destinations, set monitor levels, and enable Talkback (see “Main Tab” on page 10)
Speakers tab: Route signals to speakers and set individual channel output levels (see “Speakers Tab” on page 12)

This chapter begins with a Quickstart tutorial for several common tasks and continues with a discussion of each tab.

QuickStart

This section quickly guides you through several useful tasks. See each tab’s section for more information.

Creating a Source

To create a new Source:

1 In the Sources tab, enter a name in the Name field.

2 Choose a Start channel from the Start channel selector.

Channels 1-8 are used by the Euphonix Monitor Core Audio driver for internal busses from the application.

Channels 9-16 are used for external, physical inputs to audio hardware I/O, such as an external CD player.

3 Choose a format from the Format selector (Mono, Stereo, 5.1).

The selected Start channel and format determines which SME channels are used for the new Source. Note that the Start
channel must be low enough to allow the number of contiguous channels in the format. For example, if the format is 5.1,
the highest Start channel for a Source using SME’s internal busses is 3 (channels 3-8), so they do not intrude on the ex-
ternal inputs.

4 Click Create.

SME creates the new Source and adds it to the list of Sources available in the Main tab.

Deleting a Source

To delete a Source:

1 Select a Source in the Section Information area.

2 Click Delete.
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Routing a Stereo Source
To route stereo audio from a Mac application into SME:
1 Inyour DAW application, select Euphonix Monitor Core Audio as the output driver.
2 In SME, go to the Sources tab and select Stereo from the Format menu.
3 Click in the Name field and enter a name for your DAW.
4 Select 1 from the Start Channel menu.
This creates a stereo monitoring source for SME mixer input channels 1 and 2.

5 In the Main tab, enable the source.

This can also be done from the Setup: Monitor or Setup: Control Room Touchscreens on the Artist Series device.

Using Talkback

To enable and use a talkback mic:

1 In the Config tab, select your audio device from the Audio Device menu.

2 Connect a microphone to a mic preamp, and connect the preamp output to your audio device.
Let’s use audio device channel 8 for this example.

3 Set an appropriate input gain.

4 In the Patching tab, choose the SME input channel (SME In 9-16) to receive Talkback on.
Let’s use SME In 16 for this example.

5 Choose audio device 8 from the Audio Device In menu that corresponds to SME In 16.
This is just a generic name. You will see your audio device’s name in this menu.

6 In the Sources tab, create a mono source named Talkback (see “Creating a Source” on page 5).

7 In the Sources tab, select 16 from the Start Channel menu.

8 In the Main tab, select the mono source Talkback for each Section requiring talkback routing.

9 Talkback can be engaged using any of the following methods:
 Select the Talk button in the Setup: Control Room Touchscreen on Artist Control.
 Press the Talkback key on an Artist Series device.
* Select the Talkback checkbox in the Main tab.

Talkback can now be sent to the Control Room, Monitor A, and Monitor B.
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Sources Tab

The Sources tab lets you create Sections for SME mixer inputs. A Section must be created in the Sources tab before it is available
in the Main and Patching tabs.

Main |~ Sources | Patching Speakers = Config

Talkback

~ Start Ch | Name Format |

Pro Tools 5.1 Mix 5.1

Pro Tools HP Mix 1 maono
Pro Tools HP Mix 2 maono
External Stereo (7&8) stereo
Talkback maono

Sources tab

New Section
The controls in New Section let you name, configure, and create Sources.
Name

Click in the Name field to enter a Section name.

Start Channel

Selecting a start channel from the Start channel menu determines which SME channels will be used for the new Source based on
its format (see below).

e Channels 1-8 are used by the Euphonix Monitor Core Audio driver for internal busses from the application.
« Channels 9-16 are reserved for external, physical inputs to audio hardware 1/0, such as an external CD player.

Format

The Format menu lets you assign a format for the selected Section (Mono, Stereo, 5.1).

Create

After naming and configuring a Section, you must click the Create button to create the Section and make it available to other tabs.

Section Information

Existing Sections appear in rows in the Section Information area. Each row includes the Section’s Name, Start channel, and Format.

Delete

Clicking the Delete button with a Section selected deletes that Source. The Delete button is inactive when nothing is selected.
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Patching Tab

The Patching tab provides controls to route audio between your applications that use the Euphonix Monitor Core Audio driver and
your audio hardware.

Q All SME applications must use the Euphonix Monitor Core Audio driver.

The Patching tab lets you route the following.
e SME inputs from external hardware inputs
e SME inputs from applications that use the Euphonix Monitor Core Audio driver
e SME outputs to hardware outputs

Main = Sources | Patching | Speakers  Config

Out 1: Mbox Pro
Out 3: Mbox Pro
Out 2: Mbox Pro
Qut 5: Mbox Pro
Out 6: Mbox Pro
Out 4: Mbox Pro

Out 1: Application

Qut 2: Application

Out 3: Application

Qut 4 Application

Qut 5: Application

Qut &: Application

Qut 7: Application

Qut 8 Application

In 5: Mbox Pro
In &: Mbox Pro

None = None
MNone - None v
None s Qut 7: Mbox Pro -
None - Qut 7: Mbox Pro %
None v

Out 8: Mbox Pro
In 1: Mbox Pro v

Out 8: Mbox Pro

Patching tab

Inputs

The Inputs section provides the following sections and controls.
 Application Out SME In 1-8 (Eight SME inputs patched from the application’s outputs)
* Audio Device In  SME In 9-16 (Eight SME inputs patched from the workstation’s hardware inputs)

Outputs

The Outputs section routes audio device outputs to SME’s Main, Alt 1, Alt 2, Monitor A, and Monitor B outputs.

Using the Patching Tab

The selectors let you assign monitor channels for main and alternate speakers and headphone cue mix feeds. They can also function
as a virtual patchbay.

To change the layout (format) of a 5.1 output:

1 Select the Patching tab.
2 Use the menus to change the output routing of your monitors instead of physically repatching their outputs.

For example, you can change from L-C-R-Ls-Rs-LFE to L-R-Ls-Rs-C-LFE.
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Config Tab

In the Config tab, you can do the following.
 Select the Audio Device
 Adjust the Dim and Fixed level controls

Main = Sources = Patching = Speakers C g~

-20.0
Digidesign Mbox 2 Mini 4 e

»

Config tab

Audio Hardware

Audio Device

The Audio Device menu lets you select the audio hardware’s device driver to use with SME.

Input and Output Channels

These fields display the number of 1/0 channels allowed by the selected Audio Device.

Dim Level

This slider sets the Dim Level when the Dim button is active on the Main tab or the Setup: Control Room Touchscreen on the Artist
Series device. You can also double-click in the field above the level slider and enter a value.

Fixed Level

This slider sets a Fixed Level for the Control Room output. You can also double-click in the field above the level slider and enter
a value.

This is useful for sending the DAW output at a fixed level to a separate mixer or router that has its own level controls.

¥ When the output driver is changed, patching is reset to default settings with no external or output patches enabled. Patches must then
be reassigned in the Patching tab.
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Main Tab

In the Main tab, you can do the following.
» Adjust level sliders, settings, and assign Sources for Control Room, Monitor A, and Monitor B
 Globally enable Talkback for Control Room, Monitor A, and Monitor B

Changes made in SME’s Main tab are reflected on the surface of any connected Artist Series devices, and vice versa.

ain | Sources  Patching  Speakers = Config

Section Section Section

Pro Tools 5.1 Mix | Pro Tools 5.1 Mix D Pro Teols 5.1 Mix
Pro Tools HP Mix 1 Pro Tools HP Mix L Pro Toals HP Mix 1
Pro Tools HP Mix 2 Pro Tools HP Mix 2 Pro Tools HP Mix 2
Extarnal Stereo (7&8) External Stereo (7&8) External Stereo (7&8)
Talkback Talkback Talkback

Main tab

Control Room

Level

This slider adjusts the Control Room level. You can also adjust the Control Room level by the following methods.
e Turn the CONTROL ROOM/MONITOR knob on any connected Artist Series device.
» Double-click in the field above the level slider and enter a value.

Dim

When the Dim button is enabled, the signal is attenuated to the Dim Level set in the Config tab (see “Config Tab” on page 9) during
Talkback.

Cut

When the Cut button is enabled, the signal is completely muted during Talkback.

Fix

When the Fix button is enabled, the signal is set to the Fixed Level specified on the Config tab (see “Config Tab” on page 9).

This is useful for sending the DAW output at a fixed level to a separate mixer or router that has its own level controls.
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Speaker Select

The Control Room output can be routed to one of three speaker setups: Main, Alt1, Alt2.
Format

The Control Room’s selected speaker setup can have one of three formats: Mono, Stereo, 5.1.
Left Speaker Phase

When Reverse is selected, the phase of the left Control Room output channel is reversed.

Source
This routes Sections created in the Sources tab to the Control Room. Select a Section in the Sources box, or from the Setup: Control
Room Touchscreen on the Artist Series device. A Section must first be created in the Sources tab (see “Sources Tab” on page 7).

Monitor A and B

Monitor A and B have identical controls, so they are discussed together in this section.

Section | Section

Pro Tools 5.1 Mix ] ProTools 5.1 Mix
Pro Tools HP Mix 1 Pro Tools HP Mix 1
Pro Tools HP Mix 2 Pro Tools HP Mix 2
Extarnal Stereo (7&8) Extarnal Stereo (7&8)
Talkback Talkback

Talkback and Monitor A and B settings in the Main tab
Level

These sliders control the Monitor A and B levels. You can also double-click in the field above the level slider and enter a value.

Q The Monitor A level can also be adjusted by holding down a Function key and turning the CONTROL ROOM/MONITOR knob.
The Monitor B level can only be adjusted from this tab.
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Dim
When enabled, this attenuates the signal to the Dim Level set in the Config tab (see “Config Tab” on page 9) during Talkback.

Cut

When enabled, this mutes the signal completely during Talkback.

Source

This routes Sections created in the Sources tab to Monitor A and/or Monitor B. Select a Section in the Sources box, or from the
Setup: Monitor Touchscreen on the Artist Series device. A Section must first be created in the Sources tab (see “Sources Tab” on

page 7).

Talkback

Select the Talkback button to globally enable Talkback to Control Room, Monitor A, and Monitor B.

Speakers Tab

The Speakers tab lets you attenuate and mute speaker output levels. Control Room (Main, Alt1, and Alt2), Monitor A, and Monitor B
each have their own controls.

Control Room Main and Alt1 can be 5.1-channel, but Control Room Alt2, Monitor A, and Monitor B can only be stereo.

Main = Sources = Patching | Speakers | Config

S
*
*
*
*
*

Speakers tab

Dragging the sliders to the left lowers the level, and to the right raises it. The level is displayed in the Trim field to the right of the
slider, where you can also enter a value.

Enabling a Cut button mutes that channel’s output.
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Chapter 4: Using SME in Windows

Once connected, SME lets you do the following.
e Switch between multiple speaker setups
e Mute and dim monitor outputs
« Ultilize Talkback
 Adjust levels for external sources, such as a CD player

Seven tabs help patch and configure audio between SME and your workstation.
» Sources tab: Create SME Sources (see “Sources Tab” on page 15)
e Patching tabs: Assign routing between SME, applications, and hardware (see “Patching Tabs” on page 16)
 Config tab: Configure Dim, Fixed, and Talkback levels and select an Audio Device (see “Config Tab” on page 19)
e Main tab: Assign Sources to monitor destinations, set monitor levels, and enable Talkback (see “Main Tab” on page 21)
» Speakers tab: Route signals to speakers and set individual channel output levels (see “Speakers Tab” on page 23)

This chapter begins with a Quickstart tutorial for several common tasks and continues with a discussion of each tab.

QuickStart

This section guides you through several useful tasks. See each tab’s section for more information on each control.

Creating a Source
To create a new Source:
1 In the Sources tab, enter a name in the Name field.
2 Choose a start channel from the Start channel selector.
3 Choose a format from the Format selector (Mono, Stereo, 5.1).
The start channel and format determine which SME channels are used for the new Source.
4 Click Create.

SME creates the new Source and adds it to the list of Sources available in the Main tab.

Deleting a Source

To delete a Source:

1 Select a Source in the Source Information area.

2 Click Delete.
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Routing a Stereo Source

To route stereo audio from a Windows application into SME:

1

2

3

In your DAW application, select your ASIO output driver.

In SME’s Sources tab, select Stereo from the Format menu.

Click in the Name field and enter a name for your DAW.

Set the Start channel to 1.

Click Create.

A stereo monitoring source is created from SME input channels 1 and 2.

In the Main tab, select this source in the Sources area of each destination you wish to route to (Control Room, Monitor A, Monitor B).

This can also be done from the Setup: Monitor and/or Setup: Control Room Touchscreens on the Artist Series device.

Using Talkback

To enable and use a talkback mic:

1

14

Connect a microphone to a mic preamp, and connect the preamp output to your audio interface.
Let’s use channel 1 for this example.

Set an appropriate input gain.

In the Config tab, enable the hardware input port associated with channel 1 on your audio interface.
In the Hardware I/P Patch tab, select TB from the SME I/P menu that corresponds to Hardware I/P 1.

In the Config tab, choose Talkback Destination(s), and an Action to occur during Talkback.

e Dim lowers the Destination’s level to the Dim Level set in the Config tab.

e Cut mutes the Destination’s level.

... does not alter the Destination’s level.

The Action selected for Control Room, Monitor A, and Monitor B occurs whether its corresponding Destination is selected or
not. For example, if the Control Room Action is Cut, but Control Room Destination is not selected, the Control Room will be
muted during Talkback but will not have the Talkback signal.

Talkback can be engaged using the following methods.

 Select the Talk button in the Setup: Control Room Touchscreen on the Artist Series device.

e Press the Talkback key on the Artist Series device.

« Select the Talkback checkbox in the Main tab.
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Sources Tab

The Sources tab lets you create Sources for SME mixer inputs. A Source must first be created in the Sources tab before it is avail-
able in the Main and Patching tabs.

Studie Monitor Express =]
Main Sources SME O/F Patch | Application O/F Patch | Hardware I/F Patch | Speakers Config |
New Source
Name : 5.1 multichannel
Create
Start channel Fomat : |51 7
Source Information

Name Start channel Farmat
source 2 7 a1
stereo source 14 51

Sources tab

New Source

The controls in New Source let you name, configure, and create Sources.

Name

Click in the Name field to enter a name.

Start Channel

Selecting a start channel from the Start channel menu determines the first SME channel used for the new Source.

Format

Select a format for the Source from the Format menu (Mono, Stereo, 5.1). The Source uses the number of channels in the selected
Format beginning at the selected Start channel.

Create

After naming and configuring a Source, you must click the Create button to create the Source and make it available to other tabs.

Source Information

Existing Sources appear in rows in the Source Information area. Each row shows the Source’s Name, Start channel, and Format.

Delete

Clicking the Delete button with a Source row selected deletes that Source.
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Patching Tabs

Three Patching tabs let you route audio between applications and audio hardware that uses ASIO.

SME O/P Patch Tab

The SME O/P Patch tab lets you route SME Monitor outputs (Main, Monitor A, Monitor B, Alt 1, and Alt 2) to audio 1/0 hardware.

SR Express @

Main Sources SME O/F Patch lication O/P Patch | Hard I/P Patch | Speal Corfig |
SMEO/P Hardware O/P SMEO/P Hardware O/
Main Left 1 - AltT Left 1 -
Main Center 2 - Alt1 Center S
Main Right 3 - Alt1 Right 3 -
Main Left Suround 4 - Alt1 Left Sumound 4 -
Main Right Surmound 5 - Alt1 Right Sumound 5 -
Main LFE 6 - Alt1LFE 5 -
SMEO/P Hardware O/P SMEQ/P Hardware O/
Monitord, Left =k - Alt2 Left 1 -
MonitorA Right 8 = Alt2 Right F—
SMEQ/P Hardware O/P
MonitorB Left
MonitorB Right

SME O/P Patch tab
Hardware O/P Menus

To route Monitor outputs, select the desired hardware outputs from the corresponding Hardware O/P menus.
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Application O/P Patch Tab

The Application O/P Patch tab lets you route application outputs (Application O/P) to hardware outputs (Hardware O/P) directly and/or
SME inputs (SME I/P).

'.Studio Monitor Express 1
|Mair1 |Sources |SMEO;’P Patch | Application O/F Patch | Hard I/P Patch | Speal Corfig |
Application O/F Hardware O/F SME I/P Application O/P Hardware O/F SME I/P Application O/F Hardware O/F SME /P

1 - - [~ 20 = = KL =

2 — - 2 - 21 — - [ 40 o

3 EE 2 el e 41

4 — 4 23 T— | 42

5 S B 24 S = 43 7z B

6 ol 2 s (e a =

7 e e 26 T ? 45 2=

s B B5|| 7 B OB| ¢ & L

] | [ 28 | T 47 =

10 T G 29 -~ = 48 =
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Application O/P Patch tab
Hardware O/P Menus

The Hardware O/P menus let applications using the ASIO driver bypass SME to route signals directly to hardware outputs.

SME I/P Menus

The SME I/P menus let applications using the ASIO driver route signals into the SME mixer.

Selecting both a Hardware O/P and SME I/P simultaneously creates a mult.

Q Outputs must be enabled in the Config tab before they are available from the Hardware O/P and SME /P menus.
Using the Application O/P Patch Tab

These selectors let you assign monitor channels for main and alternate speakers, cue mix feeds for headphones, and other output
destinations. If the main outputs from your DAW application are Hardware O/Ps 1-6, they would typically be routed to SME O/Ps
1-6. However, it is also possible to route the speaker outputs in a different order (such as SMPTE format) than your monitors.

To change the layout (format) of a 5.1 output:
1 Select the Application O/P tab.
2 Use the menus to change the output routing of your monitors instead of physically repatching their outputs.

For example, you can change from L-C-R-Ls-Rs-LFE to L-R-Ls-Rs-C-LFE.
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Hardware I/P Patch Tab

The Hardware I/P Patch tab lets you route audio from the hardware inputs (Hardware I/P) on your audio interface to your applica-
tion’s inputs (Application I/P) and/or SME’s mixer inputs (SME I/P).

| Studio Menitor Express

Main | Sources | SME O/P Patch | Application O/P Patch | Hardware I/P Patch |Speakers I Config |
[ Hardware /P Application /P SME /P | | Hardwars I/P Application /P SME /P | | Hardware 1/P  Application I/P SME /P |
1 - 20 35
2 0 21 40
3 22 41
4 23 42
5 24 43
6 25 44
7 26 45
H 27 45
5 28 47
10 25 48
if 30 45
12 A 50
13 32 51
14 33 h2
15 M 53
16 . 35 54
17 36 55
12 v 56
19 38

Hardware I/P Patch tab
Application I/P Menus

The Application I/P menu routes a hardware input to an application input.

SME I/P Menus

The SME I/P menu routes a hardware input to an SME input.

Using the Hardware I/P Patch Tab

To route audio from a hardware input to an application, the Hardware I/P must be patched to the Application I/P. We recommend a
one-to-one patch to make it easier to track the mapping between physical inputs and DAW input channels. However, it is possible
to re-route a hardware input to a different input. For example, if the kick drum is on the Hardware I/P 24 and you want it to appear
on your DAW at input 1, select 1 from the Application I/P 24 menu.

Q Outputs must be enabled in the Config tab before they are available from the Application I/P and SME I/P menus (see “Patching
°  Tabs” on page 16). Enable only the outputs you need to minimize CPU resources used by SME.
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Config Tab

In the Config tab, you can do the following.
e Set Dim, Fixed, and Talkback levels
« Set an Action to occur at the Talkback Destination
e Enable/disable hardware /O ports that patch sources to destinations
 Load and save all SME settings
» Display CPU Usage and Sample rate information

Studio Monitor Express | £
Main | Sources | SME Q/P Patch | lication O/F Patch | Hard I/P Patch | Speal | Canfig
Set Dim Level Set Fixed Level CPU Usage
ol BT — = | = [00%
Talkback Sample rate
Level : ] 44100 Hz
Action Destination
Control Room Control Room Settings
Monitor A Meritor A SME Settings Studio1
Monitor B Monitor B &
b Lo
Enable hardware ports
Qutput Input
EE)EIE EEIEE = A EEG)EEE)(FEIEED
111213 )14 (1516 ](17 ] 18 (15 |20 111213114 J15](16
(2122 (23 )24 |[25]|26 |[27 (28 )(23 ][ 30 21)(22)(23)(24)(25](26
31)(32](33 |34 (35)(36 ][ 37 ]| 38 31](32]33 (34 )(35](36
(21](42](43 5 48 41)(42])(43)(42])[25) (36
51)(52)(53)(54)(55)(56 515 54(55)(56
Config tab

Set Dim Level

This sets the signal attenuation when using Talkback. The field to the right of the slider displays the current value.

Set Fixed Level

This sets the fixed output level, which is selectable in the Main tab for the Control Room output. The field to the right of the slider
displays the current value. This is useful for setups calibrated to a specific reference level.

CPU Usage
This meter shows SME’s CPU usage.

Sample Rate

This displays the current sample rate to which SME is locked. The sample rate is set on your audio hardware, so this is an indicator

only.
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Settings

These controls save the current settings or load previously saved settings. This lets you quickly switch between different SME con-
figurations.

Load

This lets you load a file with previously saved settings. The current file name in use is displayed above the Load and Save buttons.

Save

This lets you save SME’s current settings to a file.

Enable Hardware Ports

This lets you explicitly enable or disable each SME port. This limits the ASIO stream inputs and outputs monitored by SME, thus
minimizing traffic on the audio bus (and CPU usage) to only those ports necessary for the current setup. Only ports enabled here
are available for routing on the Main and Sources tabs.

Talkback

Level

This slider sets the Talkback Level for all destinations. The field to the right of the slider displays the current value.

Action

Separate Actions can be selected for Control Room, Monitor A, and Monitor B when a Talkback signal reaches that Destination.
The Action menu contains Dim, Cut, and --- options (--- does not Dim or Cut the signal).

Destination
When selected, these checkboxes enable Talkback for Control Room, Monitor A, and Monitor B.

When the Destination checkbox is selected, the Action selected for that Destination occurs when Talkback arrives.
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Main Tab

In the Main tab, you can do the following.
e Adjust level sliders, settings, and assign Sources for Control Room, Monitor A, and Monitor B
 Globally enable Talkback for Control Room, Monitor A, and Monitor B

Changes made in SME’s Main tab are reflected on the surface of any connected Artist Series devices, and vice versa.

| Studio Monitor Express
Main Sources SME O/P Patch lication O/F Patch | Hard I/P Patch | Speal Corfig |
Control Room Monitor A Monitor B
C @ Dim [
[l cut Dim E=) [ Dim
[ Foced [Ccut o
[ Phase

ou
51 - stereo source stereo source
source 2 source 2
stereo source
source 2
Talkback
[} or / off [c] 2017, Avid

Main tab

Control Room

Level

This slider adjusts the Control Room level. The field below the level slider displays the current value.

Turning the CONTROL ROOM/MONITOR knob on any connected Artist Series device also adjusts the Control Room level.
Dim

When the Dim button is enabled, the signal is attenuated to the Dim Level set in the Config tab (see “Config Tab” on page 19) during
Talkback.

Cut

When the Cut button is enabled, the signal is completely muted during Talkback.

Fixed

When the Fixed button is enabled, the signal is set to the Fixed Level specified in the Config tab (see “Config Tab” on page 19).

Phase

When selected, the phase of the left Control Room output channel is reversed. Phase can only be adjusted in the Main tab.
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Control Room Speaker and Format Selectors
The top menu (Main in the figure above) contains the speaker options (Main, Alt1, Alt2) to which the Control Room can be routed.

Select a Control Room speaker, then select its format (Mono, Stereo, 5.1) from the lower menu.

Sources

This routes Sources created in the Sources tab to the Control Room. Select a source in the Sources box, or from the Setup: Control
Room Touchscreen on the Artist Series device. A Source must first be created in the Sources tab before it is available to other tabs
for patching (see “Sources Tab” on page 15).

Monitor A and B

Monitor A and B have identical controls, so they are discussed together in this section.

Monitor A Manitar B
=
[¥] Dim L] [¥] Dim
Fcut Fcut
stereo source stereo source
source 2 source 2
Talkback
& g

Talkback and Monitor A and B settings in the Main tab
Level

These sliders control the Monitor A and B levels. The field below the level slider displays the current value.

Q The Monitor A level can also be adjusted by holding down the SHIFT key and turning the CONTROL ROOM/MONITOR knob.
°  The Monitor B level can only be adjusted from this tab.

Dim
When enabled, the signal is attenuated to the Dim Level set in the Config tab (see “Patching Tabs” on page 16).

Cut

When enabled, the signal is cut completely.

Sources

This routes Sources created in the Sources tab to Monitor A and/or B. Select a source in the Sources box, or from the Setup: Monitor
Touchscreen. A source must first be created in the Sources tab (see “Sources Tab” on page 15).
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Talkback
Select the Talkback checkbox to enable Talkback. De-select it to turn Talkback off.

This setting globally enables talkback to Control Room, Monitor A, and Monitor B.

Q See “Talkback’ on page 26 to learn how to route the signal to these destinations.

Speakers Tab

The Speakers tab lets you attenuate and mute speaker output levels. Control Room (Main, Alt1, and Alt2), Monitor A, and Monitor B
each have their own controls.

‘Studio Monitor Express
Main Sources | SME O/P Patch | lication O/P Patch | Hard I/P Patch | Speakers |Cor1ﬁg

Control Room Main Control Room Alt 2
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Control Room Alt 1 Monitor B
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Certer ; D Fight D

Right B

Left Sumound D

Right Sumound , D
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Speakers tab

Dragging the sliders to the left lowers that channel’s level, and dragging to the right raises it. The level is displayed in the field to
the right of each slider.

Enabling a Cut button mutes that output channel.
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